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TD Super-View® User Instructions

1.

Overview

TD Super-View® is a powerful, feature-rich and versatile ultrasonic data presentation and analysis soft-
ware package by Technology Design Ltd. TD Super-View® is closely integrated with Technology De-
sign’s TD-Scan ultrasonic acquisition software; therefore working with the various TD-Scan modules and
TD Super-View® is seamless. TD Super-View® is available for all versions of TD-Scan software from
Version 16.00 onward and is bundled with all new software distributions. The software is primarily aimed
at pulse echo and phased array applications but certain other advanced features have been incorpo-
rated, for example: Rastered ToFD. Conventional ToFD line scans can also be viewed in TD Super-View
and a combination of ToFD & Phased Array or Pulse Echo can be viewed simultaneously.

TD Super-View® is fully customisable, allowing the operator to rearrange data on-screen in many differ-
ent views with or without weld overlay sketches. Data can be presented in A, B, C, D & Sector scan for-
mat in any combination. Data can also be presented from individual channels or indeed as a composite
view of several channels.

TD Super-View® features powerful tools to make data analysis easier and more comfortable. Whether it
is distance, depth, amplitude, angle or beam path measurement, TD Super-View® makes code compli-
ant decision making easier and more efficient.

Configuration
2.1. TD Super-View® is enabled from the Misc. tab on the Setup — Configuration drop-down menu.

Configuration Editor.
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Fig. 1

Note: If TD Super-View® is disabled, the data presentation and analysis options will revert to the
original viewing and analysis tools offered by the TDScan software. Certain data analysis tools are not
available in TD Super-View® i.e. StripScan & Long Range Corrosion Mapping. Therefore TD Super-
View® must be disabled during these operations. Conventional ToFD analysis tools, can be easily
accessed from within TD Super-View® using the contextual menu accessed by right clicking in any
ToFD B or D scan view.

TD Super-View® can be configured prior to commencement of data acquisition and it is, in most
cases, desirable to configure the software at this stage. The CPU & RAM are heavily loaded during
data acquisition, especially when multiple channels or focal laws are defined. It is therefore good
practice to limit the amount of data displayed during acquisition to a minimum.

When TD Super-View® is enabled the full waveform is captured allowing the software to be reconfig-
ured offline to display the desired views.
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2.2. To display the configuration menu, click TD Super-View Panel Layout from the Setup drop-down
menu. (For a view of the practical result of configuration see Fig 6.)
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2.3. Main Panel Control

2.3.1.The purpose of the Main Panel Control is to display comparative data from different UT
modes e.g. Phased array & ToFD. 10 Different templates may be defined in the Main
Panel.
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2.4. Sub Panel Control
2.4.1.The purpose of the Sub Panel Control is to display different data presentations simultane-

ously, e.g. A, B, C, D & S scan. Each Main Panel may be divided into 10 different Sub
Panels.

Fig. 4

2.5. Views

2.5.1.The purpose of the Views Control is to display data from different channels individually or
combined as an overlay. Each Sub Panel may be divided into 5 different Views . Views are
displayed either horizontally or vertically, controlled from the Split combo box.
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2.5.2.Display Config

The Display Config button activates the C-Scan Display Option dialogue box. The dia-

logue box is divides into two areas:

2.5.2.1. Online size control — As the name suggests, this control is only available for online
use and cannot be adjusted offline. The Online size control allows adjustment of
the number of pixels that cover an area (no. of encoder steps), e.g. If Horizontal
Zoom = 8 and Vertical Zoom = 6 then each encoder step will cover 8 pixels by 6
pixels.

Fig. 6

2.5.2.2. Colour control — provides the choice of three modes for displaying the colours in the
C-scan sub panel.

2.5.2.2.1. Amplitude — The colours represent the amplitude/colour combination derived
from the amplitude colour bar (see section 5.5).

2.5.2.2.2. Depth (First) - The colours represent the depth/colour combination derived from
the depth colour bar. The colour in each pixel represents the depth of the first A-
scan to cross the amplitude threshold within the scan area the pixel covers. Set
the desired amplitude threshold in the Threshold (%FSH) text box.

2.5.2.2.3. Depth (Biggest) - The colours represent the depth/colour combination derived
from the depth colour bar. The colour in each pixel represents the depth of the
highest amplitude A-scan within the scan area the pixel covers. The amplitude
entered in the Threshold (%FSH) text box will exclude all signals below this
threshold to ensure that no noise is included in the C-scan.

Fig. 7
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2.6. B-Scan Direction

2.6.1.The B-Scan Direction control has 2 choices: Primary or Secondary. B-Scan direction refers
to the creation of a B-scan image in relation to direction of probe movement, e.g. if Primary
is chosen for the B-scan direction, then the secondary movement axis will trigger the crea-

tion of a D-scan (Fig. 2).

S-scan

Fig. 8
View Orientation In Relation To a Weld
3. Opening Data Files
The actions taken to display data vary dependant on the type of data presented
3.1.1.Data is displayed by opening the data file in one of two methods:
3.1.1.1. Press F9 or click the Analyse menu and select the required data file or files.

3.1.1.2. Click the Open Scan File from the File menu and select the required data file or
files. Additional data files can be opened using this option after a data file is opened

for analysis.

Fig. 9
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4. Customising the Workspace

Fig. 10

4.1. Resizing Main Panels, Panels & Views

Main Panels (multiple), panels & views can be resized at any time. Resizing a panel or view will
automatically adjust other displayed workspace areas to fit the available main panel space.

4.1.1.Place mouse pointer over the division between panels or views. The mouse pointer will
change to a double arrow .
4.1.2.Left-click, hold and drag the division to the desired position and release.

4.2. Resizing images

4.2.1.C-scan — There are 4 menu choices for resizing a C-scan image and several keyboard short-
cuts (Table 1). Right-click in the C-scan sub-panel to activate the contextual menu.

4.2.1.1. Best Fit - image fills the available workspace in relation to the originally defined scan
size.

4.2.1.2. View 1:1 — image is displayed in the relationship of 1 collection step = 1 screen pixel.

4.2.1.3. Zoom Out - reduces image size.

4.2.1.4. Zoom In — enlarges image size by activating a rubber box. Drag the rubber box to
cover the desired zoom area.

4.2.2.B-scan — B-scan views within the same sub-panel are linked to each other as well as to the C-
scan image, therefore adjusting the size of the B-scan image will automatically resize any
other B-scan views as well as the C-scan view. To resize a B-scan:

4.2.2.1. Place the mouse pointer in the View space.

4.2.2.2. Press the + or — keys repeatedly to increase or decrease the image. Holding the
Shift key simultaneously increases the adjustment step. (Table 1 for detailed zoom
information.

4.2.3.D-scan — There are currently no zoom controls for D-scan images.

4.2.4.S-scan — A Sector scan is a side view ‘snap-shot’ of a slice through the volume of the material.
A Sector scan may be part of a wider area scan of the material or a view from a static probe
position on the material surface. If the C-scan sub-panel is activated, by default, the asso-
ciated S-scans are linked to the C-scan and are subject to limited size adjustment by resiz-
ing the C-scan image. To de-activate this link:
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4.2.4.1. Right-click while the mouse pointer is in the S-scan sub-panel to activate the contex-
tual menu

4.2.4.2. Select Follow C-scan .

4.2.4.3. To re-activate the link between C-Scan & S-scan repeat the previous two steps.

4.2.5.A-scan — An A-scan can be zoomed in two directions:

4.2.5.1. Horizontal — Press the + or — keys to increase or decrease the image width. Holding
the Shift key simultaneously increases the adjustment step. The A-scan image can
be moved horizontally by holding the left mouse button and moving the mouse
pointer to the desired position.

4.2.5.2. Vertical - Hold the CTRL key and press the + or — keys to increase or decrease the
image height. Holding the Shift key simultaneously increases the adjustment step.
The A-scan peak may be viewed up to 400% in 14-bit and 100% in 8-bit mode.

5. Data Display

The following sections are aimed primarily at offline use for analysing saved data. The principles of us-
age are however basically the same for online or offline operation.

To display ultrasonic data in TD Super-View®, the software must be activated prior to data collection.
Data collected while TD Super-View® is deactivated can only be displayed in the legacy formats of the
TD-Scan software.

In this section it is assumed that the user has followed the instructions in Section 2 and has configured
TD Super-View® to display the required data

5.1. Sectorial Scans

A sector scan is essentially a multi-angular side view of a slice through the test material viewed per-
pendicular to the direction of sound propagation. When viewed off-line, sector scans can be viewed
as single images (snap-shot) or as multiple stacked scans.

5.1.1.To view a sector scan open the required file (section 3.1). The image is displayed in the S-
Scan sub-panel. If an A-scan sub-panel is configured, no A-scan data is displayed until a
focal law is selected:

5.1.1.1. While holding the Shift key, move the mouse pointer over the S-scan image.

5.1.1.2. As the mouse pointer moves over each angle or focal law, the A-scan for each corre-
sponding focal law (angle) will be displayed in turn giving the appearance of a live A-
scan display and thus recreating the echo dynamic pattern of the defined angular
range sweeping across the area of interest. Releasing the Shift key fixes the A-scan
image of the active focal law.

An alternative method:
5.1.1.3. Select Cursors from the contextual menu by right-clicking inside the S-scan sub-
panel.
5.1.1.4. Move the cross-hair across the S-scan image. Each A-scan for the corresponding fo-
cal law (angle) will be displayed in turn.
5.1.1.5. Select an angleffocal law with the cross-hair. Right click to deactivate the cross-hair
cursor. The A-scan for the selected angle or focal law will remain displayed.

5.1.2.As the mouse pointer or cross-hair cursor are moved over the image, channel, focal law, X po-
sition, Y position, angle, range or depth and amplitude are displayed in the information tray
below the scan image or in coloured flags in the view space.

5.1.3.To improve the visual appearance of the image, a smoothing filter may be accessed from the
Image Filter item on the contextual menu by right clicking in the S-scan view. Select either
the Smoothing (Low) or Smoothing (High) option.
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Fig. 11

5.2. C-scans
A C-scan is a plan-view of the test area from the scan surface of the material. C-scans are made
up from individual A-scans stacked together to form a composite image of the entire scan area.

The C-scan is used to measure position in the length and width of the scan and also to activate B, D
& S scan views (Fig. 10). As the mouse pointer or cross-hair cursor are moved over the image,
channel, focal law, X position, Y position, amplitude and volume corrected depth are displayed in
the information tray below the C-scan image or in coloured flags in the view space. To display any
of the associated views, a Single Cursor is activated in the C-scan sub-panel. By moving the cur-
sor across the C-scan image, individual B, D or S scans will be displayed in the appropriately con-
figured sub-panels related to the position of the cursor.

5.2.1.To activate the Cursor:
5.2.1.1. Right-click while the mouse pointer is in the C-scan sub-panel to activate the contex-
tual menu
5.2.1.2. Select Single Cursor .
5.2.1.3. To de-activate cursor, repeat the previous step.

An alternative to activating the single cursor is to press Shift while moving the mouse pointer over

the C-scan image, the A, B and D scans will be displayed in relation to the mouse pointer position.
Releasing Shift will fix the position of the A, B and D scans.

Fig. 12
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5.3. B-Scans
A B-scan is a side view (slice) of the diagnostic area viewed at 90° to the direction of sound propaga-
tion. B-scans can be formed from stacked single-angle A-scans. (A sector scan is in effect a multi-
angled B-scan)

To improve the visual appearance of the image, a smoothing filter may be accessed from the Image
Filter item on the contextual menu by right clicking in the S-scan view. Select either the Smoothing
(Low) or Smoothing (High) option.

As the mouse pointer or cross-hair cursor are moved over the image, channel, focal law, X position,
Y position, angle, range or depth and amplitude are displayed in the information tray below the C-
scan image or in coloured flags in the view space.

Fig. 13

5.4. A-Scans

A-scans are activated by moving a cursor across either the C-scan or B-scan image of the appro-

priate channel. Additional control is achieved by right clicking the mouse while in the A-scan view

panel and activating a contextual menu:

5.4.1.Follow Colour Bar — This control causes the visible A-scan amplitude to re-adjust when the
Colour Bar to the right of the workspace is adjusted manually.

5.4.2.Time Base in Range - This control changes the time base scale to millimetres. When the con-
trol is disabled the time base scale is displayed in micro-seconds.

5.5. Amplitude Colour Ramp
The colour ramp on the right of the workspace may be used to alter the apparent gain of the B, C,
D & S-scan images and amplitude of the A-scan image by moving the upper limit of the colour bar
up or down:
5.5.1.Move the mouse pointer over the black line at the upper limit of the colour bar. The mouse
pointer will change to a double arrow.
5.5.2.Hold the left mouse button and move the colour bar up or down. The sub-panel image colours
will adjust according to the redefined colour bar setting.
5.5.3.'Reject’ can also be simulated:
5.5.4.Move the mouse pointer over the black line at the lower limit of the colour bar. The mouse
pointer will change to a double arrow.
5.5.5. Hold the left mouse button and move the colour bar up or down. The sub-panel image colours
will adjust according to the redefined colour bar setting.
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6. Additional Analysis Tools
There are several tools provided in the software designed to make data analysis easier and more effi-
cient.

6.1. Echo Dynamics

To activate the echo dynamic:

6.1.1.Right click while the mouse pointer is in a B or S scan sub-panel to activate the contextual
menu.

6.1.2.Highlight Echo dynamics.

6.1.3.A sub-menu appears. Choose either Horizontal to activate the box below or Vertical to acti-
vate the box to the right of the sub-panel.

6.1.4.Activate the cross-hair cursors in the sub-panel by right clicking in the sub-panel and choosing
cursors from the contextual menu.

6.1.5.Move the cursors over the image to display the echo dynamic. The echo dynamic is essentially
an amplitude envelope of the cursor line through the image.

To measure size from the echo dynamic:

6.1.6.Place a cross-hair cursor over the highest amplitude of the indication of interest in the sub-
panel image.

6.1.7.The corresponding echo dynamic is displayed in the echo dynamic box.

6.1.8.Right click in the eco dynamic box and select the desired amplitude boundary/s. 6dB or 20dB
boundaries may be selected for display independently or simultaneously. Choose a scaling
factor that will ensure the highest amplitude peak is visible.

6.1.9.Move the red line to the highest amplitude on the echo dynamic by dragging the line with the
mouse. Fine control is achieved by holding the left mouse button down while the mouse
pointer is over the line. Note the black dashed line/s will correspond to the amplitude
boundary/s defined in 6.1.8 and cross the echo dynamic at the amplitude stated on the cor-
responding flag.

6.1.10. Position the left and right blue lines at the point where they bisect the amplitude boundary
line and the edge of the echo dynamic. TIP: Try to match the values on the blue and black
flags as closely as possible.

6.1.11. The defect size is displayed in the dY flag in the upper left or right corner of the echo dy-
namic box.

Fig. 14
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6.2. Skip Correction
Skip correction is a method of displaying multiple skip legs as a linear plot (Fig 13). The software
recognises the skips and plots the depth correctly according to the range (Fig 14).

20mm

P omm

Fig. 15

6.2.1.To display skip correction correctly, the Skip Correction control must be enabled. If skip cor-
rection was not enabled prior to scanning it may be enabled in analysis mode as follows:

6.2.1.1. Open the desired scan file.

6.2.1.2. Select File Data then Hardware Setup from the File drop-down menu. The Collec-
tion Hardware Setup window appears.

6.2.1.3. From the Channel tab click the Probe button to display the probe setup dialogue
page.

6.2.1.4. In the Skip Correction dialogue area click the Enabled check box.

6.2.1.5. The material thickness may already be displayed in the Material Thickness text box;
this will be the case if Pulse Echo Skip Correction was enabled in the Global tab
either prior to scanning or off-line. If not, enter the correct material thickness.

6.2.1.6. Click OK

6.2.1.7. Note: All active channels must have the same material thickness entered.

6.2.2.Skips may be displayed as an overlay on a B or Sector scan. The Leg number and depth will
be displayed as flags on lines corresponding to the scan surface and backwall of the mate-
rial. To display the skip lines:
6.2.2.1. Right click in the B or S scan view.
6.2.2.2. Select Show Skip from the contextual menu. The skip lines appear on the image.

Fig. 16

6.3. Weld Overlay
Weld overlays are graphic representations of standard weld preparation geometries superimposed
onto the data image. Weld overlays may be displayed on B, C and Sector scan images. Before
displaying a weld overlay, the weld preparation geometry must be defined:
6.3.1.0pen the desired scan file.
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6.3.2.Select Overlay Control from the View drop-down menu. The Overlay Configuration window
appears.

6.3.3.Select the appropriate weld prep from the tabs. The left and right side of the weld prep may be
defined independently or click the Same check box if the geometry is symmetrical.

6.3.4.Fill in the dimensions in the appropriate text boxes. TIP — to define a K-prep, use the Single V
tab and define one side with the thickness in text box 2 only.

6.3.5.Fill in the Centre Line Position text box. This dimension is the distance from the bottom ele-
ment on the wedge to the datum (usually the centre of the weld) and will ensure that the
overlay is positioned correctly over the data image.

6.3.6.Click OK.

6.3.7.The weld overlay is displayed. If Skip correction is enabled, the weld overlay is displayed as
a fold-out image on B and S scan images and a plan view on C scan images. If skip correc-
tion is enabled and displayed, the skip correction lines should match the top and bottom of
the weld prep images (Fig 16). The lateral position of weld overlays can be adjusted by
dragging the centre line left or right.

Fig. 17 Fig. 18

6.4. C-scan Cursors

C-scan cursors provide a means to define a selected plane through the test material thickness that

is viewed in plan view. To operate:

6.4.1.Right click in a B or S scan view. A contextual menu appears.

6.4.2.Select C-scan Display Gate to activate. Two red, parallel double-dotted dashed lines appear.
If the lines are not visible, zoom into the image until they are visible.

6.4.3.Drag the lines individually to the desired position on the image. After each movement of a line,
a dialogue box appears. If you want to refresh the C-scan to reflect the new settings, click
Yes in the dialogue box. Tip: click No until the desired position of both C-scan cursors has
been set before clicking Yes. The C-scan is now recreated and only the volume defined by
the C-scan cursors is displayed in the C-scan view.

Fig. 19 Fig. 20
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Appendix 1

Zoom Control Key

Shift Key

View Mode (z;olﬁ?/n) (zoorfqegut) (I:rggtr |éfeyp) nove mege) arge Step)
i - i =t

B - - B
C _
D - B - - - B
S - B
A Time Base Time Base - Left/Right -

Ctrl + Cirl -

Amplitude Amplitude - - - -

Table 1
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